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Introduction to EndNote20 Desktop 
EndNote20 helps you to store, manage and search for bibliographic references in a personal 

database. You can attach full-text PDF articles to references.  

You can also take advantage of EndNote’s “Cite While You Write” facility to insert citations 

(references) in a Word document and generate a list of references at the end of the document in a 

wide variety of styles.  
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1. Downloading EndNote 20 Software  

1.1 Downloading EndNote 20 for home 

Under the terms of our licence LJMU students and academic staff may download EndNote from 
https://www.ljmu.ac.uk/ithelp/software-for-staff-and-students and install it on their own PC or 
Mac to run alongside Word. This includes the desktop version of Word available via Microsoft 
Office 365.  

You must uninstall EndNote when you leave LJMU. 

 

1.2 Downloading EndNote 20 (Windows) on Staff PC  

Staff can request the installation of EndNote 20 desktop on an LJMU devices via the Software 
Centre:  https://helpme.ljmu.ac.uk/#servicecatalogue and search “software” and submit a 
request.  

Once installed you will see in Word an EndNote 20 tab appears on the ribbon, to access EndNote 
select Go to EndNote in the EndNote ribbon.  

 

1.3 Creating and opening an EndNote Library 

EndNote stores references in files referred to as libraries.  

Please note: EndNote is not compatible with cloud base storage, for example, OneDrive, Google 
Docs, M: drive, etc. Therefore, we recommend you save your EndNote library on the hard drive of 
your device. 

To create a new library, select File and then New and Create a new library: 

 

Enter a filename if you do not wish to give your library the default name ‘My EndNote Library’ and 
then select Save.  

In addition to the above library file EndNote will create an accompanying folder, for example:  My 
EndNote Library.data.  

To open an existing EndNote library, start EndNote, then select File and then Open Library and 
select the appropriate library.  

Only create one EndNote library, if you are collecting references on a range of topics for different 
assignments/projects or documents, you can easily assign references within a library to one or 
more groups to make things easier to manage.  

Only work with one Word document open at once. 

https://www.ljmu.ac.uk/ithelp/software-for-staff-and-students
https://helpme.ljmu.ac.uk/#servicecatalogue
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2. EndNote Library Screen   

EndNote defaults to the All References panel:  

 

Across the top of the three sections is an EndNote toolbar, selecting each option will reveal a 

submenu:  

• File: to open, save, share, compress a library and more 

• Edit: for preferences, fonts and more 

• References: to add a new reference, find full text, attach files and more 

• Groups: create, delete and add references to a group and more  

• Library: sync, find duplicates, move fields and more  

• Tools: styles, filters, CWYW and more  

• Window: display 

• Help: updates and guidance  

The left-side menu has a number of default folders/options which cannot be removed. The Library 
defaults to: 

• Sync Configeration: to sync with an EndNote Online Account 

• All References: this is the default screen and where all your references will appear 

• Recently Added: this shows references added when you have your library open  

• Unfiled: these are references that have not been moved to a Group (folder) 

• Trash: records that you have deleted  

• My Groups: to store/manage references into folders  

• Find Full Text: to search for PDFs 

• Groups Shared by Others: folder of references shared with a colleague 

• Online Search: connection files to search some databases via EndNote  

 

 

3. Adding References 

EndNote defaults to the All References panel where all your references will be stored: 
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There are several ways to add references to an EndNote library: 

• Adding references manually 

• Exporting references direct from Discover and individual databases 

• Adding references from an Online Search within Endnote  

• Exporting from a Google Scholar search 

• Creating EndNote records from a collection of PDF articles  

 

The All References panel has some default headings/fields, you can change the order of these 
headings, remove headings or add more.  

To make any changes select Edit on the toolbar, then Preferences, from the box select Display 
Fields. You can also switch any heading on/off by right clicking any of the headings and selecting 
the ones you wish to display. 

References can be sorted by author, year, etc. You can change the display order by selecting a 
heading: 

 

 

3.1 Manually Adding References  

Select References from the toolbar, then New Reference or select the Add New Reference icon 

   

 

A New Reference template will open, defaulting to Journal Article. Select the dropdown menu to 
choose a Reference Type. If you change the reference type, select the Author field of the selected 
template before you start typing details.  

Press the Tab key or select the next field to move through the reference. 

Please Note: Choose Electronic Article not Journal Article, if you wish the URL and accessed date 
to appear in a reference in your Word document. Choose Book section to reference to a chapter 
in an edited book. 

Author names:  

• Enter either as first middle last: John Edward Smith or last, first middle: Smith, John Edward  

• If you enter last name first include a comma between the author’s last name and initials or 
last name and first names. EndNote will reduce first names to initials, if the style you have 
chosen for your reference list requires it.  

• As you type, EndNote will suggest names already in your library that are similar to the one 
you are entering. To accept a suggestion, press the Tab key.  
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• If you are entering a new name, keep typing until you have completed the name and then 
press Enter.  New authors’ names appear in red until the reference is saved.  

• If an item has more than one author, press Enter when you have entered the first name 
and enter the second name on a second line in the author field. Do not put “and” between 
the names: 

 

• Organisations/Societies/Government Departments, add a comma after the name of the 
organisation, for example: Department of Health, this will ensure that it is displayed 
correctly:   

 

 

Punctuation: enter all details in plain text, for example: no brackets, extra punctuation, bold, 
italics or underlining. EndNote will automatically add the punctuation where necessary when it 
generates a reference in the style you have selected. 

Spaces: avoid gaps within a reference, do not include any unnecessary spaces or these gaps will 
appear in the reference. 

Electronic articles and eBooks (using Harvard LJMU style): complete the Date Accessed field and 
the DOI or the URL field if you want the web details to appear in the full reference. 

Webpages/Reports (using Harvard LJMU style): complete the Date Accessed field and URL field to 
display the web details in the reference. 

Save: Select Save and then close the reference window when you have entered all the relevant 
details. 

Please Note: To insert accented or other non-standard characters in a reference, use the Windows 
Character Map program. This is available via Start, Windows Accessories, System Tools, Character 
Map. Select the character you need, copy and paste it into the relevant location in the reference. 

 

3.2 Exporting References  

Discover and many individual databases offer a “Direct Export” option. This allows you to search 
within the database, select references and then export them to your EndNote library in a matter 
of seconds. 

Exporting involves selecting the references in your search results by selecting the title(s) or adding 
them to your folder, then selecting an export option and a format: EndNote or RIS. 

If your EndNote library is open, you will then be prompted to add the exported references to your 
EndNote library. If EndNote is not open, it will open and then the references will be added. If an 
Open or Save option appears after you selected to export using the direct export references 
option from a database, select Open to complete the process. 

Please Note: If you wish to use this facility when running EndNote from home, you may need to 
launch EndNote before attempting to export references from a database. 
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3.2.1 Discover: Exporting References  

To export an individual search result from Discover, select the Title to open the item record. A 
range of options will appear underneath Send To:   

 

• Select EndNote and select Download 

• The next step differs depending on the web browser you are using:  

Chrome: a RIS export folder will appear at the bottom of the screen, select the up arrow 
to open the File Menu and choose Open  

Microsoft Edge: a RIS Download folder will appear in the top right-hand corner of the 
screen, select Open file  

Internet Explorer: a toolbar will appear at the bottom of the screen, select Save and 
when prompted, choose Open 

• This will open your EndNote Library and the reference will be imported from Discover 

 

Once the reference is imported, you will see an Imported References folder appear in the left-side 
menu and a confirmation message in the window:  

 

The full reference is also in the Unfiled and All References folders where it appears greyed out 
until you import more references or close your library. 

To export multiple references, select the Push Pin icon  next to each of references you wish to 
export to add them to your My Favorites list 

• Select Push Pin   at the top of the screen to open your My Favorites list  

• Select the checkboxes next to the references you would like to export: 

 

• Select the 3 dots, select EndNote then select Download 

 

Once the references are imported, you will see an Imported References folder

 in the left-side menu and a confirmation message in the 

window:   

The full references are also in the Unfiled and All References folders and they will appear greyed 
out until you import more references or close your library.  
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Please Note: The titles in some references you export may be all in capitals. To correct this once 
you have the reference in your library you can edit the contents of the title field.  

 

3.2.2 Databases: Exporting References  

Exporting from databases involves selecting the references in your search results by either ticking 
boxes or adding them to a folder and then exporting the selected references or the references in 
the folder. There are different export options depending on the database, for example:  Download 
citations, Export Citations or Export    

 

When you select the export option, you may need to select a level of detail for each reference 
(typically citation only or citation and abstract) and then look for the EndNote or RIS format 
option: 

 

The next step differs depending on the web browser you are using:  

Chrome: an export folder will appear at the bottom of the screen, select the up arrow to 
open the File Menu and choose Open  

Microsoft Edge: a Download folder will appear in the top right-hand corner of the screen, 
select Open file  

Internet Explorer: a toolbar will appear at the bottom of the screen, select Save and when 
prompted, choose Open 

Once the references are imported, you will see the Imported References folder

 in the left-side menu and a confirmation message in the 
window: 

 

The full references are also in the Unfiled and All References folders and they will appear greyed 
out until you import more references or close your library.  

Please Note: It is possible to import references from different databases into a single EndNote 
library, but the references must be imported through the appropriate filter. 

 

3.2.3 Google Scholar: Exporting References  

In Google Scholar:  

• Select Settings in the menu bar , scroll down to the Bibliography manager options. 

• Select Show links to import citations into and change the drop-down option to EndNote   

   
• Save 
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Each record in the search results will have a Cite icon  select this. At the bottom of the Cite 
box select EndNote. This will create a scholar.enw file. 

The next step differs depending on the web browser you are using:  

Chrome: an export folder will appear at the bottom of the screen, select the ^ arrow to 

open the File Menu and choose Open  

Microsoft Edge: a Downloads folder will appear in the top right-hand corner of the screen, 
select Open file  

Internet Explorer: a toolbar will appear at the bottom of the screen, select Save and when 
prompted, choose Open 

Once the reference is imported, you will see an Imported References folder 

 appear in the left-side menu and a confirmation message in the window:  

 

The full reference is also in the Unfiled and All References folders where it appears greyed out 
until you import more references or close your library. 

 

3.2.4 Online Search in EndNote  

EndNote has several database and catalogue Connection Files, which allow you can perform 
searches, for example: PubMed and Discover, the library search system, adding references directly 
into your EndNote library.  

Access is via ONLINE SEARCH  in the left-side menu, with more options under 
the Plus button. LJMU has subscription for many of the databases listed but please note that some 
of these Connection Files for the American versions and are not compatible with those available in 
the UK.  

Please Note: We recommend you perform the search directly in Discover or the individual 
database. 

 

If you do perform an online search directly from EndNote, then the following are the instructions 
for some of the key searches: 

Discover Search: 

• Select the Plus button under the ONLINE SEARCH heading 

• Scroll down the list and select Liverpool JMU Discover from the list of connection files and 
then select Choose 

• A Liverpool JMU Discover search window will open in EndNote  

• Select which fields to search or Any Field to search all fields and then type your search 
term(s) into the box: 
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• To refine a search, add another term, limit the search to specific fields, use the Boolean 
operators. To add another term to a search, select Cancel to return to the Search tab 

• Select the references you want to add and then select the Add button   to add them to 
your library  

• The references will appear both in the All References and Recently Added folders

  
• The search results are also in a temporary Liverpool JMU Discover folder 

 but these will disappear when you close your library 
 

Individual Database Search, for example: PubMed: 

• Select PubMed (NLM) from the list of services under the ONLINE SEARCH 

• A PubMed (NLM) search window will open in EndNote 

• Select which fields to search or Any Field to search all fields and then type your search 
term(s) into the box: 

• To refine a search, add another term, limit the search to specific fields, use the Boolean 
operators:   

 

• To add another search term, select Cancel to return to the Search tab. You can halt the 
retrieval process at any time just select the Cancel button on the Search tab.  

• Select the references you want to add and then select the Add button   to add them to 
your library  

• The References will appear in both the All References and in Recently Added folders

  
• The search results are also in a temporary PubMed (NLM) folder 

  which will disappear when you close your library 

 

3.2.5 Creating EndNote records from a collection of saved PDF articles 

If you already have a collection of journal articles in PDF files, EndNote may be able to create 
records for them automatically. This only works with PDFs created recently by publishers who 
embed bibliographic data (typically a DOI) in the documents.  

To export multiple PDFs put them into one folder and open your Endnote library  
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• Select File and select Import 

• Select File for an individual PDF or Folder for multiple PDFs  

• Select Choose to navigate to the file (PDF) or folder, select it and select open 

• Import Options:  PDF should already be selected, if not, use the dropdown menu to select 
PDF: 

 

• Select Import 

• Imported references appear in Imported References folder   

 

 

A copy of any PDFs with embedded DOI data will be imported into new records with matching 
bibliographic data. You may need to edit the journal title and article title fields so that they match 
the style that you wish to use. 

PDFs without embedded DOI data are added to individual default journal article records and the 
file name of the PDF will be displayed in the title field of the record. Select the record and in right-
side panel select Summary then Edit and enter details of the items to the records manually.  

 

4. Reviewing your search results 

We recommend that each time you have finished searching, before closing your library, you 

review the references in the Unfiled folder .   

It is essential that you check that all the details needed to create the reference for your reference 
list are there, so the references are ready for when you want to Cite While You Write (see Section 
7). Once you have checked them you can add them to your Groups (see Section 5), leaving the 
Unfiled folder empty for next time.  

 

4.1 Checking the Reference is correct 

• Select a reference  

• Select Summary  in the right-side panel to see the details    

• The default referencing style will be Annotated. Select the drop-down menu 

 to change the referencing style and select the dropdown arrow and select 
your chosen style, for example, Harvard LJMU: 
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If your style is not listed, select Select Another Style   , find your style, highlight it 
and select Choose  

OR 

• Select Tools and select Output styles   

• Then select your style from the list. If it is not listed, choose Open Style Manager and 
search for the referencing style you require. 

 

A preview of the reference can be seen in the bottom of the panel, if this does not look correct 
you will need to amend/update the template (see Section 4.2):  

 

 

Please Note:  Journal titles may be displayed as an abbreviated title so you will need to amend this 
(see Section 4.2) and enter in the full title. To display the URL and access details in a reference you 
need to change reference type from Journal Article to Electronic Article. 

Once you have checked each reference move it into a Group (see Section 5). 

 

4.2 Editing a Reference in EndNote   

• Select the reference in the All References panel   

• Select Edit  in the right-hand side panel   

• Select the fields that need amending, make sure you do not leave any spaces and then 
select Save  

• Move the reference to a Group (see Section 5)  
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5. Managing your references into Groups 

As your EndNote library grows, it is good practice to organise your references into Groups. You 
can add references one or multiple groups but they will always remain in All References.  

 

5.1 Creating a Group and adding references to it 

• From the Groups menu, select Create Group  or right click on MY GROUPS in 

the left-side menu  and select Create Group 

• In MY GROUPS in the left-side menu, New Group is now highlighted, type in a name and 
press Enter 

• Select All References to display the entire library again 

• Highlight the references you wish to add to the new Group 

• Drag the highlighted references to the new group or go to Groups on the toolbar menu and 
select Add References To and select the Group you want to move the references to 

• Select the Group to display the references now included in that Group:  

 

 

5.2 Deleting a Group 

• On the left-side menu, right click on the Group name and select Delete Group or select 
Groups on the toolbar menu and then select Delete Group  

• Select Yes to confirm you wish to delete the group 

Please Note: Only that Group is deleted, the references it contained are not deleted from your 
library. 

 

5.3 Renaming a Group 

• On the left-side menu, right click on the Group name and select Rename Group OR select 
Groups on the toolbar menu and then then select Rename Group  

Please Note: You cannot change or delete: All References, Duplicate References, Find Full Text, 
Imported References, Recently Added, Search Results, Trash and Unfiled. 

 

5.4 Removing References from a Group 

• To remove a reference, select the Group in the left-side menu to display its contents 

• Select the reference(s) you wish to delete and then press Delete 

• Select Yes to confirm that you wish to delete the selected reference(s) from the group 
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5.5 Deleting references from your library 

• To delete references from your library completely select the reference(s) in All References 

• You can then either drag them to the Trash folder or from the toolbar menu select 
References and then select Move References to Trash 

• To restore records from the Trash to your library, display the Trash group, select the 
references you wish to restore and drag them over to All References or select the Restore 

icon  

• To permanently delete the references from your library, display the Trash group, select the 

references you wish to permanently delete, press delete or select the Delete icon and 
then select Yes to confirm 

Please Note: References deleted from the Trash folder cannot be recovered. 

 

5.6 Duplicates 

If you have collected references from several databases, your library may contain some duplicate 
references. We recommend you check your library for these and delete any that you find.  

• Select Library, then Find Duplicates  

• The number of duplicate references found are displayed in the Duplicate References folder

 
 

 

 

• Select the Keep this Record button for the reference you want to retain 
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6. PDFs and Full Text  

It is possible to store PDF articles and other documents within your EndNote library as well as their 
bibliographic details.  

 

6.1 Searching for free full-text articles PDFs from within EndNote 

Some journal articles are freely available from websites, to check whether any of the references in 
your library fall into this category:  

• Select the reference(s) and select Search Web for Full text icon   

• The progress and results of the search are displayed on a line below in the left-side menu 

   

• If EndNote finds a free full text version article in PDF it will attach a copy of the file to the 
File Attachments field of the reference  

• If EndNote finds an article which is freely available in HTML, it will add a hyperlink to the 
article to the URL field or DOI field   

This facility does not always pick up articles available to members of LJMU through paid 
subscriptions. 

 

6.2 Attaching PDF articles in your EndNote library 

To attach a PDF file to a reference from your OneDrive or other storage space, highlight the 

reference and select Attach file   in the right-side panel, navigate to the file (PDF), 
select it and select open. 

PDF files are stored in the PDF sub-folder within the .data folder, which accompanies your 
EndNote library. 

 

6.3 Creating EndNote records from a collection of saved PDF articles 

If you already have a collection of journal articles in PDF files, EndNote may be able to create 
records for them automatically. This only works with PDFs created recently by publishers who 
embed bibliographic data (typically a DOI) in the documents (see section 3.2.5).  

 

6.4 Opening PDFs attached to references in EndNote 

To open a PDF file attached to a reference, select the reference and then select the PDF dropdown 
menu for options to open the PDF: 

 

To open a hyperlink in a reference select Edit option or if you have added URL to your display 
panel (via Cog) then right click on the link and select Open URL. 
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PDFs attatched to EndNote references can also be viewed via the PDF option, this loads the PDF 
into panel with options to print, email or open the PDF in a separate window. 

 

6.5 Annotating PDF files 

You may find it useful to make notes or annotate PDFs when you are reading/assessing them. 

A PDF opened in EndNote has a toolbar:    

Select the Markup/annotation icon   to see a submenu:  to add sticky notes, 
highlight and underline or cross out text.  

There is also the option to hide any markups or annotations if you right click on the PDF.  

 

 

7. Citing and generating a list of references list in a Word  

EndNote has a “Cite While You Write” (CWYW) feature which allows you to incorporate references 
from your EndNote library in a Word document as you write it.  

 

7.1 Inserting a reference(s) into a Word document 

• Select the EndNote 20 tab within Word 

• Check that Instant Formatting is on:   

• Place the cursor at the point in the text where the reference sh

 

ould appear 

• Select Go to EndNote  

• Select the reference in your EndNote library, select Insert Citation      

OR 

In Word select Insert Citation , search for the reference, highlight it and select Insert: 
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OR  

In EndNote: highlight the reference you wish to insert then select Tools, then Cite While You 
Write (CWYW) and Insert Selected Citation(s): 

 

It may take a few seconds for the citation to appear and the full reference to appear at the end of 
your Word document. 

Each time you insert a reference a brief citation appears in the text and the full reference is added 
to the reference list at the end of the document. To insert several references as a multiple citation, 
select the references in your EndNote Library and follow the above instructions. 

 

7.2 Editing and Managing Citations 

You can edit a citation to change the citation display, add page numbers, a suffix or prefix. To edit 
a citation, select the citation in Word – it will appear greyed out. Select Edit & Manage Citation(s)  

. The reference will be highlighted in blue in the EndNote 20 Edit & 
Manage Citations dialog box: 

 

 

7.2.1 Author (year) 

The default for a citation is (author, year). In the Edit Citation box, under Formatting, select 
Display as: Author (Year). Select OK to save the change: 
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7.2.2 Add a Page Number 

To add a page number to a citation for a quote type the page number in the Pages field in the Edit 
Citation box, select OK to save the change: 

 

 

7.2.3 Add a Paragraph or Line Number 

To add a paragraph or line number to a citation for a quote from a web page type the paragraph 
or line number starting with a space in the Suffix field in the Edit Citation box, for example, para.4 
select OK to save the change: 

 

 

7.2.4 Add a Start Time 

To add a start time to a citation for a quote from an audio or video source type the start time 
(using the 24-hour clock) starting with a colon and then a space in the Suffix field in the Edit 
Citation box, for example, : 00:04:30 select OK to save the change: 

 

 

7.2.5 Secondary Reference/Source 

To indicate a secondary reference, you will need to type the additional citation details in the Prefix 
field in the Edit Citation box: 

• To enclose the whole citation in brackets: put author, year cited in and put a space after 
cited in 
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• Enter the page number in the Pages field, select OK to save the change: 

 

 

• To display the author outside the bracket, enter year cited in and put a space after cited in  
• Enter the page number in the Pages field, select OK to save the change. You will need to 

manually type the secondary reference author(s) name directly before this citation in your 
Word document: 

 

 

7.2.6 Remove a Citation 

To ensure that a citation is removed cleanly from your text and from the list of references at the 
end of the document unless you have referred to it elsewhere in the document: 

• Select the citation in Word – it will appear greyed out 

• Select Edit & Manage Citation(s)  

The reference is highlighted in blue in the EndNote 20 Edit & Manage Citations dialog box. 

• Select the Edit Reference drop-down menu and select Remove Citation and select OK to 
save the change 

 

 

If this is the only time the citation appears in your document, then the reference will be removed 
too. If it this citation is elsewhere in the document only the highlighted citation is removed, the 
reference will remain. 

 

7.3 Referencing Styles in Word 

To change the referencing style in your Word document, use the Style drop-down menu. 

If necessary, you can change the font and/or size of the text in your reference list to match the 
font and/or size of the text in the body of your essay. To do this: 
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• Select the arrow in the bottom corner of the Bibliography box on the EndNote 20 tab:    

 

• Select the Layout tab and select the appropriate font and sizes   

• Select OK to apply changes made 

There are also options under the Layout tab to add a title to a reference list, to change the line 
spacing within and between entries on the list and change the depth of the indent for the second 
and subsequent lines within entries. 

 

7.4 Removing EndNote Code and Converting to Plain Text  

If you wish to remove field codes and disconnect your Word document from your EndNote Library 
you will need to save the formatted citations and reference list as plain text: 

• Open your Word document and make a backup copy of your document by selecting the 
File and Save As to save this backup copy with new name 

• Using the backup copy of your document, on the EndNote 20 tab, select Convert Citations 

and Bibliography  

• Select Convert to Plain Text   from the dropdown men. You will be 
prompted to continue and save this copy of your document without field codes which will 
disconnect from EndNote. 

Please Note: This plain text copy does not contain Cite While You Write field codes, so you cannot 
reformat it with Cite While You Write.  If you need to reformat your document, you will need to go 
back to the original document, which retains field codes and links to your Endnote library and then 
repeat the above process if you need to save a plain text copy of your document. 

 

7.5 Printing selected references in a specific style 

• In EndNote select the All References panel and then select the references you wish to print 

• From the File menu select Print 

 

7.6 Copying selected formatted references from your library into a Word document 

This is useful if you need to add references formatted in a particular style to a Word document 
written without using EndNote’s “Cite While You Write” function or need to add a Bibliography as 
well as a Reference List after you have converted your document to plain text (see section 7.4). 

• Select the references in the All References panel 

• Select References on the toolbar, select Copy Formatted Reference  

• In Word paste the references into the document at the appropriate point – make sure you 
have manually inserted the citations at the appropriate place in your document 
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8. Combining chapters into a single Word document and one reference list 

You can combine chapters into a single Word document and one reference list if you have used 
the same EndNote library for all the Word documents. First you should make copies of all the 
documents containing your individual chapters, for example:  1chaptercopy.docx, 
2chaptercopy.docx, etc. Work with these copies so that you can return to the original documents 
if you have any problems.  

• Open your first chapter backup copy document for example:  1chaptercopy.docx in Word 

• This will become the master copy which will contain all the chapters 

• On the EndNote 20 tab in Word, select Convert Citations and Bibliography and select 
Convert to Unformatted Citations option 

• Your citations will now appear in their unformatted state, for example: {Baker, 2007 #22}, 
and the reference list at the end of this document will disappear 

• Open your second chapter backup copy document, for example:  2chaptercopy.docx in 
Word and unformat the citations as above  

• Select and copy the entire text of the second chapter and paste it into the end of your 
first chapter copy document 

• Repeat above steps with the remaining chapters until you have copied them all in 
sequence  

You may now wish to rename your 1chaptercopy.docx as, for example:  mastercopy.docx  

• Open your Endnote library, if you have not already done so as you now need to reformat 
the citations in your mastercopy.docx.  

• Check that the correct referencing style is displayed in both EndNote and Word 

• On the Endnote toolbar in Word select Update Citations and Bibliography  

EndNote will scan the new document for citations and generate a single, new reference list at 
the end of the document. If it finds any mismatches between author name and reference 
numbers in your document and EndNote library, EndNote will prompt you to specify which item 
you wish to cite.  

 

9. PowerPoint: Adding references into slides 

 

• Open a PowerPoint and check your Style is correct 

• Select the EndNote 20 tab and select Go to EndNote - check your style is selected  

• Select the required reference(s) in EndNote  

• In the PowerPoint slide select Insert Selected Citation(s)  

• On the last slide and select Insert Selected Reference(s)   from the PowerPoint 
ribbon to create the reference list 
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10. Making a back-up copy of your EndNote library 

It is always a good idea to make a back-up copy of your EndNote library regularly. A compressed 
library file saves your MyEndNoteLibrary.enl file, its associated .Data folder, and all its contents to 
a single compressed file.  

   

10.1 Creating a Compressed Library File 

• Open your library in EndNote 

• From the File menu, select Compress Library (.enlx) to display a Compressed Library dialog 
box 

• Use the radio buttons to choose from these options: 
− Specify whether you want to Create a compressed library or Create & Email the library 
− Specify whether you want to With File Attachments with the library or not 
− Specify whether you want to save All References In Library, only the Selected 

References, or only the references in a specific Group/Group Set 
− Select Next to display a file dialog 

 
• Save the compressed library to a different location from your working library, for example, 

OneDrive. You can rename the file if you wish. Please Note: NEVER open your compressed 
EndNote Library from your OneDrive 

• If you select Create & Email, EndNote will launch your default email system, create a new 
email message, and attach the compressed library file to the email. Add the email address 
of the recipient, the subject, and message and select Send  

 

10.2 Restoring a Compressed Library File 

• Copy the compressed library file to the hard drive of your device 

• Open this version of the .enlx file via Open on the File menu in EndNote 

• This will extract the .enl file and the .Data folder to the same folder where the. enlx file is 
located 

• Use EndNote to open the .enl file as normal to use the library 

 

11. Troubleshooting 

 
Accessed date in references to webpages not displayed 
Different referencing styles take the access date information for references to web 
pages/documents from different fields. Check there is a date in the Access Year and Access Date 
fields, the Latest Update Date field and the Year Cited and Date Cited fields. 
 
Amended reference in EndNote library not appearing in the Word document 
Open your EndNote library and Word document, check that the appropriate style is selected in 
both. In the EndNote 20 tab in Word select Update Citations and Bibliography in the Bibliography 
box.  
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Details are not displaying in the references  
Some styles will not display all the details you provide about items. If a reference to a journal 
article includes a URL which is need in the in the reference in a Word document, change the 
reference type from Journal Article to Electronic Article in EndNote. 
 
Organisation displayed incorrectly  
Enter the name of an organisation/society/government department in the author field followed by 
a comma immediately after the name, for example:  Liverpool John Moores University, 
If the name has a comma, insert a second comma immediately after the one in the name rather 
than at the end of the name, for example:  Department for Business,, Innovation and Skills 
 
Citation looks strange 
For example: “{Smith, 1981 #18}” when it should be (Smith, 1981). Check that Instant formatting 
is On in the EndNote 20 toolbar in Word. If it is Off, select the button to turn it on. 
 

12. Further help  

• EndNote Canvas Course: https://canvas.ljmu.ac.uk/enroll/EDA36F 

• Help menu in EndNote or in the EndNote 20 tab in Word 

• Websites:  http://clarivate.libguides.com/endnote_training/users/en20  and 
https://www.youtube.com/user/EndNoteTraining  
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